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Introduction

Brief Description

The EaseUS Todo Backup application allows you to backup files and folders in the original
or compressed format, and then restore them back. Use of the program does not require
special computer skills.

You can run tasks manually or automatically according to the time schedule.

In addition to the backup functionality, the program allows you to synchronize the content
of duplicate folders keeping the most recent versions of files. Also you can create a
bootable clone of your hard drive.

The program requires OS X 10.9 or higher.

Why the Creation of Data Backups is Important

A backup is an additional copy of computer data that can be used to restore the original
after a data loss. The data loss can be caused by a computer malfunction, natural disaster,
user's mistake or other causes. You never know beforehand when this may happen. To
protect your data, you should create backup copies of your files.

Which files are worth backing up? Think about the documents that you have created.
Probably the only copy in the world is on your hard drive. Such a document is a candidate
for inclusion in a backup. It is advisable to create a backup copy of your mail. You can also
save the information related to your user account (in case you have to re-install the
operating system).

You shouldn't backup programs, clip arts and other computer data if you have it on
installation discs. Also there is not much sense it backing up relatively small files or
installation packages if they are available for free in the Internet.

Note that if you backup confidential information, you should make sure you keep the
backup archives in a safe place.

Different Approaches to Backups
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EaseUS Todo Backup consists of several tools which let you back up your files in different
ways. You can create a backup, archived backup, clone a hard disk or sync the content of
a pair of folders.

A backup is a way to place copies of files in another location while preserving the original
formats of these files. This is useful if you need to quickly access individual files in the
backup. What is more, you can do this in Finder without using EaseUS Todo Backup.

An archived backup stores files inside an archive. You can choose to compress the
archive, thus potentially saving disk space. Such archives let you use some additional
features such as encryption or making incremental backups.

Disk cloning is a special type of backup. It creates copies of your files in the original
format. The main purpose of disk cloning is to duplicate your entire hard drive including
the system files. As a result, you can boot your computer from the duplicate drive if it was
your working drive. Cloning takes much longer than backing up only the user files. For this
reason, cloning is usually combined with more frequent backups of files you modify
regularly.

Synchronization is used to ensure that the contents of two folders are identical.
Synchronization can also be used to create copies of your files in a second location and
keep them up-to-date. As synchronization updates only files that have been changed, it is
faster than copying all files every time.

There is a significant difference between the two types of backup on the one hand, and
synchronization and disk cloning on the other. The first two tools can save versions of your
files. This means that if you have set up daily backups, today's backup can be stored
along with yesterday's and earlier ones. Thus, you can retrieve not only the most recent
but also earlier copies of your document. Cloning and synchronization are designed to
keep only the most recent versions of files.

Updating the Program

To have the most recent version of the program, you just need to install updates as soon
as they are released. Before launching the update installer, make sure that the application
and supporting files are at the default locations. Usually they are if you have followed the
installation procedure and didn't change paths or transfer files manually. For default file
locations, see in the Uninstalling section.

You can set up to check for updates automatically in the program Preferences.

To check for the latest update manually, use the EaseUS Todo Backup > Check for
Updates command in the main menu. Also, you can visit the EaseUS Todo Backup
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Downloads page:
https://www.easeus.com/download/backup.html

If you are going to install a major update, for instance, update version 3 to version 4, it is
recommended that you deactivate the schedule agent in the Preferences before updating.

Uninstalling the Program

Before uninstalling the program, you should deactivate the schedule agent. To do this,
launch the EaseUS Todo Backup application. Choose EaseUS Todo Backup >
Preferences in the menu. Deselect the Use schedule agent checkbox, and click OK.
Quit the program.

To uninstall EaseUS Todo Backup downloaded from the developer's site, delete the
following files and folders:
/Applications/EaseUS Todo Backup.app
~/Library/Preferences/com.easeus.EaseUSTodoBackup.plist
~/Library/Application Support/ETBLauncher
~/Library/Application Support/EaseUS Todo Backup

IMPORTANT:
Folders marked with bold font contain auxiliary files with project settings and some other
details. Do not delete these folders to be able to use EaseUS Todo Backup for restoring.
Without having the project settings, it is still possible extract files from your backups
manually.

“~” means user’s Home folder.

To access any path listed above, copy it. In Finder, choose Go > Go to Folder
(Cmd-Shift-G). Then paste the path into the edit box, and click the Go button.

Licensing

You can find your license code in the purchase confirmation email.

To enter the license code:
1. Open the application.
2. Bring up the License dialog by choosing EaseUS Todo Backup > Registration… in
the menu.
3. Enter your name and license code.

It is recommended that you keep the e-mail containing your license code in a safe place in
case you re-install or update the application.

https://www.easeus.com/download/backup.html


EaseUS Todo Backup for Mac user guide

4

The unlicensed version of EaseUS Todo Backup is fully operational with limited trial
period.

To get a license code, you need to purchase and enter the license code. See details on
EaseUS web site:
http://www.easeus.com/backup-software/todo-backup-mac-buy.html

Technical Support

The developer of EaseUS Todo Backup offers free technical support.

By E-mail:
support@todo-backup.com

Technical support form on EaseUS website:
http://www.easeus.com/support.htm

When reporting a problem, please make sure to specify:
• The version of EaseUS Todo Backup you are using.
• The version of Mac OS installed on your computer.
• Your previous actions that could have lead to the problem.
• If the problem persists, describe how to reproduce it.
• When necessary, illustrate your report with screenshots (press Cmd-Shift-3 to save a
screenshot on your Desktop).

Useful Web Resources

EaseUS Todo Backup home page:
http://www.easeus.com/backup-software/todo-backup-mac.html
EaseUS Todo Backup buy page:
http://www.easeus.com/backup-software/todo-backup-mac-buy.html

EaseUS Todo Backup End-User License Agreement

EaseUS® Todo Backup
End-User License Agreement (EULA)
Copyright © 2004-2017 EaseUS. All rights reserved.

Please read this document carefully. This is a legal agreement between you (either an individual
or an entity) and EaseUS, the developer of EaseUS Todo Backup. This agreement supersedes any
prior version license and governs your use of the software.

http://www.easeus.com/backup-software/todo-backup-mac-buy.html
mailto:support@todo-backup.com
http://www.easeus.com/backup-software/todo-backup-mac.html
http://www.easeus.com/backup-software/todo-backup-mac-buy.html
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EaseUS exclusively owns all copyrights of EaseUS Todo Backup.

EaseUS Todo Backup is only for private or home computer usage and licensed for one computer
installation only.

Anyone may use the 30-day trial version of EaseUS Todo Backup. Before deciding upon the
purchase, you may use the trial for evaluation. After the trial is expired, you should purchase full
version.

The EaseUS Todo Backup Trial may be freely distributed, if the distribution package is not
modified. No person or company may charge a fee for the distribution of EaseUS Todo Backup
Trial without written permission from the copyright holder.

EASEUS TODO BACKUP IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR
IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS,
DAMAGES, AND LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS
SOFTWARE.

You may not use it to provide external services to your clients. You may not copy, emulate, clone,
rent, lease, sell, modify, de-compile, disassemble, otherwise reverse engineer, or transfer the
program, or any subset of the program, except as provided for in this agreement. Any such
unauthorized use shall result in immediate and automatic termination of this license and may
result in criminal and/or civil prosecution.

CUSTOMER EXPERIENCE IMPROVEMENT PROGRAM

In order to better serve our customers, and to enable our products to meet our customers
ongoing and growing needs, EaseUS launches Customer Experience Improvement Program.

The program helps EaseUS improve our products. Without interrupting you, it collects
information about your computer hardware configuration, software configuration, how you use
our products and problems you might have with our products.

If you choose to participate, we will be automatically collecting information about your hardware
configuration, software configuration and the way you use EaseUS products. We will not collect
any private information, like your name, address, phone number, or keyboard input. Participation
in the Customer Experience Improvement Program is voluntary, however, but the end results
intended to provide software improvements and enhanced functionality to better meet the
needs of our customers.

COPYRIGHT

The software is protected by International Copyright Laws and Treaty Provisions.
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EaseUS is trademark of CHENGDU Yiwo Tech Development Co., Ltd. All other trademarks are the
property of their respective owners.

EaseUS Todo Backup is the modified version of Get Backup software.

Copyright © 2017 BeLight Software, Ltd. All rights reserved.

SOFTWARE SUPPORT

Support will only be provided by e-mail and only on the most current version. Queries regarding
the installation and use of the software should be submitted by e-mail to
support@todo-backup.com. Requests for additional features and enhancements should be
submitted by e-mail to advice@easeus.com. We will attempt to implement all reasonable
requests but is not obliged to implement it. If you have questions about purchasing or updating
our products, please Email us at sales@easeus.com.

RESERVATION

EaseUS reserves the right to change the license agreement of the software. EaseUS has the right
to change the product. EaseUS reserves the right to change prices without notice. EaseUS
reserves all rights that are not expressly granted here.

Installing and using EaseUS Todo Backup signifies acceptance of these terms and conditions of
the license. If you do not agree with the terms of this license you must remove EaseUS Todo
Backup files from your storage devices and cease to use the product.

EaseUS Todo Backup Interface

The Main Window

The main window provides tools for:

 Creation of backups
 Creation of archived backups
 Cloning disks
 Synchronization

We use the term "project" to call tasks that can be set up an performed individually as
backing up some files or cloning a drive.
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1 – Choose here the project type: backup, archived backup, disk clone or synchronization.
2 – A list of projects.
3 – Buttons to add or delete projects.
4 – Settings of the current project. The current project is highlighted in the list, and its
content is displayed in the main part of the window.
5 – An option to restore files from the selected backup. Only backup and archived backup
projects have this button.
6 – The status line. It the program state or details about the currently running task.
7 – The Run button. It starts the task related to the selected project (e.g. starts backing up
files).
8 – The progress bar.
9 – The middle of the main window displays files and folders of the current project.
10 – This button opens the Log Window.
11 – The Suspend Scheduler button lets you turn off the scheduler for some time.

If the program was started automatically by a schedule, the main window will be
minimized. After completing the scheduled tasks, the program will quit.

The Preferences Dialog



EaseUS Todo Backup for Mac user guide

8

1 – Automatically check for updates lets you specify how frequently the program checks
for updates.
2 – Run the program with the administrator privileges. To activate this option, you will have
to input the administrator's password and re-start the program.
3 – The option to store the administrator's password in the Keychain. Once you activate
this option, be ready to input the user name and password. To remove the password from
the Keychain, deactivate this option.
4 – Activate this option to skip displaying the warning message before starting cloning.
The message states that the content of the destination volume will be removed. Select
this check box to run scheduled cloning with no need of user's attention.
5 – Automatically start up EaseUS Todo Backup to perform scheduled tasks. If this option
is not activated, you should open the program manually.
6 – Show the program icon in the menu bar.

The icon indicates whether the scheduler is in the regular mode or suspended. It also
gives you options to suspend or resume the scheduler, and to bring up the main window of
the program or its Preferences.

7 – Limit the number of the most recent log files stored on your computer.
8 – Determine where log files should be saved. You can specify a new location for log files
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or open their location in Finder.
9 – Choose a folder for temporary files. Normally, the system folder is used. Using a
custom folder may be helpful when:
• There is not enough space on the system volume.
• While creating a multi-volume archive (with archive size limit option), the whole path to
a temporary file is limited by 80 characters. If the program runs out of characters, you can
change the location of temporary files. Choose a temporary folder that is as close to the
root point of the file system as possible. So, a short path like "/Volume2/" is better than a
long one "/Volume2/Users/Bobby/Documents/Backups/Temporary/".

EaseUS Todo Backup Menus

 EaseUS Todo Backup
 Edit
 Process (Backup)
 Process (Archive)
 Process (Clone)
 Process (Synchronize)
 Window
 Help

Menu items marked with (*) are not available in the Mac App Store version of the program.

The "EaseUS Todo Backup" Menu

About EaseUS Todo
Backup

Display information about the program.

Pro Registration… Open the registration dialog box. (*)

Check for Updates Check for the latest update on the Internet. (*)

Preferences
(Cmd-",")

Bring up the program preferences dialog.

Quit EaseUS Todo
Backup (Cmd-Q)

Quit the application.

The "Edit" Menu

Cut (Cmd-X) Cut selected text.
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Copy (Cmd-C) Copy selected text into the Clipboard.

Paste (Cmd-V) Paste text from the Clipboard.

Select All (Cmd-A) Select all text or select all the items in the file list.

The "Process" Menu: Backup project

Start Backup Run the current backup project.

New Create a new backup project.

Remove Project… Remove the current backup project.

Add File... Add a file or folder to the current backup project.

Remove File Remove a selected file or folder from the current backup project.

Show in Finder Open a folder containing a selected file or folder in Finder.

Properties/Schedule
…

Open the properties of the current backup project.

Restore… Restore files and folders from the current backup.

Restore from…
Restore files and folders from a backup which is not listed in the
program. You should specify the location of this backup.

The "Process" Menu: Archive project

Start Backup Run the current backup project.

New Create a new backup project.

Open… Open a backup project saved in the past.

Save Project… Save the current backup project.

Remove Project… Remove the current backup project.

Add File… Add a file or folder to the current backup project.

Show in Finder Open a folder containing a selected file or folder in Finder.

Review Content… Open a detailed list of the files and folders in the backup project.

Properties/Schedule
…

Open the properties of the current backup project.
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Restore… Restore files and folders from the current backup.

The "Process" Menu: Clone project (*)

Start Cloning Start cloning the selected disk.

New Create a new disk cloning project.

Remove Project… Remove the current project.

Properties/Schedule
…

Open the properties of the current backup project.

The "Synchronize" Menu

Start Synchronization Synchronize the two selected folders.

New Create a new synchronization project.

Remove Project… Remove the current project.

Analyze Compare the two selected folders.

Choose Left Target… Choose a folder to synchronize its content with another folder.

Choose Right
Target…

Choose a folder to synchronize its content with another folder.

Properties/Schedule
…

Open the properties of the current backup project.

The "Window" Menu

Zoom Fit the program window to the screen size.

Minimize (Cmd-M) Minimize the currently active window.

Close (Cmd-W) Close the active window.

Enter Full Screen
(Cmd-F)

Fit the program window to the screen size.

Backup View (Cmd-1) Open the backup tool.

Archive View (Cmd-2) Open the archived backup tool.
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Clone View (Cmd-3) Open the disk cloning tool. (*)

Synchronize View
(Cmd-4)

Open the synchronization tool.

Show Log (Cmd-L) Open or close the log window.

Clear Log Remove records from the log window.

The "Help" Menu

EaseUS Todo Backup
Help

Open EaseUS Todo Backup documentation.

BeLight Software
Web Site…

Open developer's web site.

Send Feedback… Send feedback to the developers by e-mail.

Online Registration… Open the on-line registration form.

The Log

EaseUS Todo Backup displays information about its progress in the Log Window. Unlike
the status line, which indicates only the current state, the Log Window lists a history of
records related to the current and previous sessions. In case of an error, you can scroll
back to see what has been done and which operation has failed. If the program is set up
to run your tasks automatically, the Log Window gives you a convenient way to find out if
the recent tasks were completed successfully.

To open the Log Window, click on the Show Log Window in the main window, or select
Window > Show Log in the main menu.

The program also saves logs on your local drive. Log files are even more detailed than
logs in the Log Window. Every time you open the program, it creates a new log file. The
latter contains progress and diagnostic messages.

To access log files, click the Log History button in the Log Window.

In the The Preferences Dialog, you can choose a new folder to save logs, and limit the
number of old logs to be stored.

The program stores logs in the ZIP format. If you wish to read a log, double-click on the
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file to extract a text file from it.

Creating Backups

The Backup Workspace

To open the backup tools, click the first button in the main window or press Cmd-1.

1 – List of backup projects. Along with the project name, there is the date and time of the
most recent backup.
2 – List of files and folders included to the current project.
3 – Add or delete projects.
4 – Project properties.
5 – Open the Restore dialog to restore files from the backup.
6 – An option to exclude items from new backups without deleting them from the backup
project. If you exclude a folder, all its content will be excluded too.
7 – Add a file or folder to the project.
8 – Add files to the project from a predesigned list. Each item in the list corresponds to
user data such as contacts or a photo library.
9 – Remove a file or folder from the project. This button will actually delete top level items
from the list, but it will exclude a subfolder or file inside a folder.
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Creating Backups

To work with backups, make sure that the backup tool is activated. Choose Window >
Backup View or press Cmd-1.

Mac OS Extended file system on the local destination drive lets you use its space more
efficiently by creating incremental backups.

Step 1: Create a new backup project
Click the Plus button at the bottom of the project list. Then type in the project name.

Step 2: Set up the backup
As soon as you add a new project, the program will open the project settings. You can set
up the project right away, or do this later. Note that you must select the backup destination
drive and folder before running the project.

Step 3: Add files and folders to the project

To add a file or folder to the project, use any of these ways:
• Drag and drop a file or folder to the list on the main window.
• Click the File+ button and select a file or folder. You can select multiple items at the
same time.
• Choose Process > Add File… in the main menu and select a file or folder. You can
select multiple items at the same time.

By clicking the Apps Data+, you can choose a preset. Each of them adds user's data
related to one of listed apps.

To delete an item from the list, select it and click the File- button below the list.

Step 4: Create a backup

To create a backup, click the Start button.

If you have activated scheduled creation of backups, the process will start automatically at
the stated time.

If the When destination is mounted option is activated in the Properties dialog, the
program can also start the process automatically when you connect a USB disk to the
computer.

The Backup Properties
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To open the Properties dialog, click the gear icon below the project list or
choose Process > Properties/Schedule… menu item.

1 – The color of the tag in the project list. This can help you highlight projects by
importance, frequency of creation or by other principle.
2 – The project name. It is displayed in the main window. Note that projects with identical
names are not allowed.
3 – The backup destination drive. Here you can choose a volume, removable drive,
network drive or CD/DVD/Blu-ray drive available on your computer. If you select a network
drive, the program will display two more controls. The Network automount check box
allows the program to mount the selected disk automatically before writing files to it.
The Mount button lets you mount the selected disk manually.
4 – Select a folder on the destination drive.
5 – If the destination folder is located on a network drive, you can choose to mount it
automatically.
6 – Information about the possibility to create a backup with selected destination drive and
folder.
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7 – If the original files are located on a network drive, you can choose to mount it
automatically.
8 – The Exclude section allows you to create a set of rules for automatic exclusion of files
from the archive. By selecting the By pattern check box, you can create your own rule.
This is described in the Exclude Files by the Pattern section.
9 – Activate or deactivate removing old versions of the backup automatically.
10 – Activate the automatic backup creation when the destination disk is mounted.
11 – Activate the automatic backup creation by schedule.

Exclude Files by Pattern

A folder added to your project may contain some files which you don't want to back up.
The Exclude tool can help you automatically exclude such files.

You can choose a predefined file type or create your own pattern. To do this, activate
the By pattern option and select a file you want to exclude. For example, if you select
a report.txt file and choose the "the same extension" option, all .txt files will be excluded.

A pattern can contain a file name or extension, or both. Several patterns can be combined
to create a complex rule.

To add a pattern:
1. Click the Select button.
2. Select one of radio buttons:
• the same extension to exclude all files of the same type as the sample file has (the part
of the full file name after the most right period.
• the same name to exclude all files with the same name as the sample file has (the part
of the full file name before the most right period).
• the same name and extension to exclude all files with the same name and extension
as the sample file.
3. Choose a sample file to use its name or extension as a pattern.
4. To join the current pattern with the existing one, select the Combine with previous
pattern check box. This way you can exclude several file types from the archive. If you
deselect the check box, a new pattern will replace the existing one.
5. Click Capture.

Removing Old Backups

The more times you run the same backup project, the more versions of this backup can be
stored on your drive taking more and more space. The program can delete old versions of
the backup (let's call them old backups) in order to free disk space for new ones. When it
is possible, backups will be removed through the Trash (you should empty it manually).
Otherwise, they are removed instantly.
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The program removes old backups when you close it.

There are two ways to define which of the backups should be deleted. The first method
lets you define for how long to store backups by selecting the After option. If you set "After
2 Months", the program will keep backups created within the two recent months. Backups
created earlier will be deleted.

The second method allows you to set up the maximum number of versions stored at the
same time using the Exceeding option. If you select "Exceeding 3 versions", the program
will keep the three most recent backups.

Backup Storage

In the backup destination folder, the program creates a folder dedicated to a particular
backup project. The name of this folder is the project name plus an underscore symbol
plus an alphanumeric prefix. For example, if your project is called "Documents", the folder
name can look as Documents_4FFA23B7-207C-42BF-A9DB-A500023DD276. The prefix
is generated automatically and ensures that projects with the same name will not mix up
their backup folders.

Inside the backup folder, there are:
• gb3info.plist - an auxiliary file needed to store some information related to the backup.
• b3_2016-02-03_17-54-28 - a folder to store a version of backed up data. There can be
one or many of such folders with different date and time in their names. Every time you
run a backup project, the program creates one more folder, and copies the current version
of your files into it.

If we look at the list of items included to the project, there are files and folders that are not
inside of any other folder. Let's talk about them as top level items. So, the program places
each top level item into a folder with the same name and a unique prefixes such as
".wrp1", ".wrp2" and so on. If you go deeper in subfolders, the file structure will be exactly
the same as in the original folders.

So in the whole, the backup storage content may look this way:

Documents_4FFA23B7-207C-42BF-A9DB-A500023DD276
gb3info.plist
b3_2016-02-03_17-54-28

Document_1.txt.wrp1
Document_1.txt

Document_2.txt.wrp2
Document_2.txt
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b3_2016-03-03_17-54-28
Document_1.txt.wrp1

Document_1.txt
Document_2.txt.wrp2

Document_2.txt
Folder_1.wrp3

Folder_1
Folder_2.wrp3

Folder_2
Document_3.txt
Document_4.txt

Bold font marks the backed up files and folders. The rest were used to organize the
backup storage. To restore manually, you should copy the items in bold to the proper
locations.

Quasi-Incremental Backup Type

If the local destination drive has the Mac OS Extended file system, the program will create
incremental backups. This means that files, which have not been changed since the
previous backup, will not be copied to the backup storage again. Due to this, the program
can save space on your destination drive, and may finish each backup session faster.

Instead of copying an unchanged file to a new backup, the program creates a hard link to
a copy of this file already present in one of previous backups. To the user, the hard link
behaves as it is the file itself. So, all backups appear to be full backups.

With a file system on the destination drive other than Mac OS Extended, the program will
create versioned backups. Each of them will contain copies of all files included to the
project.

Incremental backups cannot be created on network drives.

Backup Auxiliary Files

The program stores settings and other information related to backup projects in
Projects.plist and gb3info.plist files. Without these files, the program cannot back up and
restore your data.

It is recommended that you save a copy of Projects.plist in the same folder where your
backup is located.

The Projects.plist file is one for all of your projects. It is located in the Backups folder. To



EaseUS Todo Backup for Mac user guide

19

find this folder, use the path specified on the Uninstalling the Program page.

gb3info.plist files are located inside the destination folder of each backup project. Every
project has its own gb3info.plist.

Creating Archived Backups

The Archived Backup Workspace

To open the archived backup tools, click the second button in the main window or press
Cmd-2.

1 – List of backup projects. Along with the project name, there is the date and time of the
most recent backup.
2 – List of files and folders included to the current project.
3 – Add or delete projects.
4 – Project properties.
5 – Open the Restore dialog to restore files from the backup.
6 – An option to exclude items from new backups without deleting them from the backup
project. If you exclude a folder, all its content will be excluded too. To access files inside
folders, click the View Content button.
7 – Add a file or folder to the project.
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8 – Add files to the project from a predesigned list. Each item in the list corresponds to
user data such as contacts or a photo library.
9 – Remove a file or folder from the project.
10 – Open the full list of files included to the project.

Backup Archive Types

EaseUS Todo Backup can handle two types of backup archives. Your choice should
depend on the physical amount of memory available on the backup storage, on how
frequently you create backup archives, on the reliability you expect from your archives, etc.
One type may be optimal for some specific case but not the best for others.

To set up a type for the current backup archive, choose Backup > Properties/Schedule
menu item and select a type in the Backup Method section.

You can see the difference between the discussed backup types if:
Your backup project includes several files.
You create a sequence of backup archives.
One or several (but not all) files have been changed since the last archive creation.

Full Backup

A full backup contains copies of all files and folders listed in the backup project. The size
of a full backup archive can be estimated as the total size of the original files. If you enable
the compression feature, the archive can be smaller.

You can define whether to store previous versions of the backup, or to keep only the most
recent one. To do this, use the Keep previous backups option in the project properties.

To restore files, you should have only the last version of the archive.

Incremental

An incremental archive contains only files that were changed after the previous backup
archive (full or incremental) had been created. The archive size depends on the total size
of modified files and can be much smaller than the full archive.

New incremental archives have unique names. The program places new archives into the
folder where the previous archives are located.

To restore files, you should have all the previous incremental archives including the full
archive.
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Creating Archived Backups

To work with archived backups, make sure that the archived backup tool is activated.
ChooseWindow > Archive View or press Cmd-2.

Step 1: Create a new backup project

Click the Plus button at the bottom of the project list. Then type in the project name.

Step 2: Set up the backup

As soon as you add a new project, the program will open the project settings. You can set
up the project right away, or do this later. Note that you must select the backup destination
drive and folder before running the project.

Step 3: Add files and folders to the project

To add a file or folder to the project, use any of these ways:
• Drag and drop a file or folder to the list on the main window.
• Click the File+ button and select a file or folder. You can select multiple items at the
same time.
• Choose Process > Add File… in the main menu and select a file or folder. You can
select multiple items at the same time.

By clicking the Apps Data+, you can choose a preset. Each of them adds user's data
related to one of listed apps.

To delete an item from the list, select it and click the File- button below the list.

Step 4: Create a backup archive

To create a backup archive, click the Start button.

If you have activated scheduled creation of backups, the process will start automatically at
the stated time.

If the When destination is mounted option is activated in the Properties dialog, the
program can also start the process automatically when you connect a USB disk to the
computer.

The Backup Content List
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To preview the detailed list of files and folders in a project, click the View Content button
in the main window. The main window lists only top level items.

In the list, you can exclude certain items by unchecking them. Excluded items remain
listed but they will not get into the backup. The program also automatically unchecks items
according to the Exclude settings.

A column to the right from the file name indicates the presence of the item in the original
location. No icon means that the original file cannot be found.

The Archived Backup Properties

To open the Properties dialog, click the gear icon below the project list or choose
Process > Properties/Schedule… menu item.
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1 – The color of the tag in the project list. This can help you highlight projects by
importance, frequency of creation or by other principle.
2 – The project name. It is displayed in the main window. Note that projects with identical
names are not allowed.
3 – The backup destination drive. Here you can choose a volume, removable drive,
network drive or CD/DVD/Blu-ray drive available on your computer.
4 – Select a folder on the destination drive.
5 – The Network automount check box allows the program to mount the selected disk
automatically before writing files to it. The Mount button lets you mount the selected disk
manually. These two controls are available if you select a network drive as the destination.
6 – The Exclude section allows you to create a set of rules for automatic exclusion of files
from the archive. By selecting the By pattern check box, you can create your own rule.
This is described in the Exclude Files by the Pattern section.
7 – An option to keep only the most recent version of the backup or all of them. When the
check box is activated, running the backup project will add new versions of the backup to
the destination folder taking more and more disk space. In this case, you can delete old
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backups manually. This feature is available only with the Full backup type.
8 – The type of the backup project. See Backup Archive Types for more detail.
9 – An option to create compressed archives. With compression, archives usually take
less disk space.
10 – The archive encryption method. If encryption is activated, you will have to input a
password when you backup your files, and when you restore them. You can choose to
remember the password in the Keychain.
11 – The Split size control allows you to split the archive into pieces (volumes) so that the
size of any individual volume does not exceed the stated size. This is useful when you
write backups on CD/DVD discs.
12 – Activate the automatic backup creation when the destination disk is mounted.
13 – Activate the automatic backup creation by schedule.

Exclude Files by Pattern

A folder added to your project may contain some files which you don't want to back up.
The Exclude tool can help you automatically exclude such files.

You can choose a predefined file type or create your own pattern. To do this, activate the
By pattern option and select a file you want to exclude. For example, if you select a
report.txt file and choose the "the same extension" option, all .txt files will be excluded.

A pattern can contain a file name or extension, or both. Several patterns can be combined
to create a complex rule.

To add a pattern:
1. Click the Select button.
2. Select one of radio buttons:

• the same extension to exclude all files of the same type as the sample file has (the
part of the full file name after the most right period.

• the same name to exclude all files with the same name as the sample file has (the
part of the full file name before the most right period).

• the same name and extension to exclude all files with the same name and
extension as the sample file.
3. Choose a sample file to use its name or extension as a pattern.
4. To join the current pattern with the existing one, select the Combine with previous
pattern check box. This way you can exclude several file types from the archive. If you
deselect the check box, a new pattern will replace the existing one.
5. Click Capture.

Burning Backups on CD, DVD or Blu-ray

You can save your backup archives directly to CD, DVD or Blu-ray discs. EaseUS Todo
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Backup allows you to use the disc burning capabilities provided by OS X.

To burn a backup archive using Mac OS capabilities:
1. Choose the CD/DVD/Blu-ray drive in the Backup destination drop-down menu in the
backup project properties.
2. Insert a blank, recordable disc into the drive.
3. Click the Start button or choose Backup > Start Backup in the menu.
4. Click the Burn button to start burning.

If you have inserted a rewritable disc, the program can ask you to erase it before burning
your backup.
To access more options, click the button in the top right corner.

Here you can select the Leave disc appendable check box to be able to add more files if
there is enough free space on the disc. Note that only appendable (multisession) discs are
supported.

CD, DVD or Blu-ray discs can be used for incremental or versioned backups.

You should remember that the software requires some extra space on the system hard
disk for temporary files.

Multi-Volume Archives
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If your backup archive requires more space than one disc provides, you can burn it onto
several disks. Select the disc capacity in the Archive size pop-up menu in the project
Properties dialog. The program will split the archive into several parts. Then these parts
will be merged when you restore files.

Archive File Names

The backup archive name reflects the chosen backup method and the creation time. The
following format is used:

method_project_YYYY-MM-DD_hh-mm-ss_lp.ext

Here:
method – backup method: "full" – full, "incr" – incremental, "vers" – versioned;
project – the name of the backup project;
YYYY – the year of the creation (for instance, 2016);
MM – month (for instance, 02);
DD – day (for instance, 11);
hh – hour (for instance, 16);
mm – minutes (for instance, 05);
ss – seconds (for instance, 14);
_lp – present in all file names;
ext – file extension (see below).

For example, the archive name "vers_Documents_2016-02-11_16-05-14_lp.tgz" tells us
that it is a versioned archive and it was created on February 11, 2016 at 16:05:14, with
compression enabled.

File Name Extensions

The file name extension indicates whether or not the archive was compressed, encrypted
or split onto parts. If multiple features were activated, multiple extensions will be attached
to the file name one after another.

Extension Compression Encryption

.tar – –

.tgz + –

.tar.bfe – Blowfish

.tgz.bfe + Blowfish

.tar.3des – Triple DES

.tgz.3des + Triple DES
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.tar.aes128 – AES-128

.tgz.aes128 + AES-128

.tar.aes256 – AES-256

.tgz.aes256 + AES-256

Backup archives may be split into parts (the Archive size limit option in the Backup
Properties). The consecutive parts will have the additional extension added in the end.
The extension consists of three letters that change in the alphabetical order depending on
the part number:
.tar.aaa – part 1;
.tar.aab – part 2;
.tar.aac – part 3;
and so on.

The Archived Backup Project File

When you create a backup archive, along with the archive itself, EaseUS Todo Backup
creates a backup project file that contains information necessary to restore the archived
files or create new archives. This additional file has the "bif" file name extension. The
beginning of this file's fame coincides with the project's name.

The program saves the backup project file in user's Library folder. The path to the project
file is specified on the Updating and Uninstalling the Program page.

When you choose Backup > Remove from List in the menu, the program deletes the
corresponding "bif" file. To be able to work with your backup in the future, save the project
file using Process > Save Project…, and only then remove your project from the list. To
open your backup project again, choose Backup > Open… and select its "bif" file.

It is recommended that you save the project in the same folder where the corresponding
backup archives are located. When you relocate archives, make copies of them, or burn
them to discs, place the project file together with the archives.

Restoring Files from Backups

Using EaseUS Todo Backup to Restore Files

To restore files from a backup, you should have the backup itself and all related auxiliary
files (see Backup Auxiliary Files for regular backups or Backup Project File for archived
backups). In the case of a multi-volume archive, all the parts must be present.
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To restore files:
1. In the main window, select a backup project you want to restore. Then click the Restore
button. The Restore dialog will open.
2. By default, the program selects the most recent backup in the pop-up menu. If you need
an earlier version of some file, select the corresponding backup from the list using the
creation date.
3. Select files you want to restore. To select multiple files, use the Cmd or Shift keys. To
restore all files, you don't have to select them.
4. Choose whether to restore to the original or to a custom folder.
5. Click the Restore All button to restore all files or click Restore Selected to restore only
selected files.
If the backup was encrypted, be ready to input the password.

Note that when you restore files to the original location, the program will replace files on
your disk with files from the backup. If you want to keep both versions of your files, restore
files to another folder.

If your backup project is not listed in the program, your actions in order to restore files from
this backup will differ depending on the backup type. If you have a regular backup, choose
the Process > Restore from… command from the main menu and select the folder
containing your backup (the top level folder explained in the Backup Storage section). The
program will open the Restore dialog. You can use this dialog as it was described earlier
on this page.

To restore from an archived backup, you should open it in the program using the
Process > Open… command. The further steps will be the same as described above.

The Restore Dialog

The Restore dialog contains the restoration options. To open it, click the Restore button in
the main window.
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1 – The list of already created backups for the current project. You can choose one of
them to restore the included files. A tick mark near the file name (archived backups only)
indicates that a file is present in the selected backup.
2 – The list of files and folders in the current backup project. You can select one or several
files to restore only them.
3 – Select where to restore files. If Restore to custom folder is selected, the program will
ask you to choose a folder.
4 – Select Use selected archive only to restore files only from an archive selected in the
drop-down menu at the top. This option is available only for incremental backups. It can
speed up the restoration process because the program wouldn't have to process all
incremental archives created before the selected one. Before using this option, make sure
that a tick mark is present next to a file you want to restore. If there is no tick mark, choose
another archive where the file is ticked, or restore with this option deactivated. This option
is available only for archived backups.
5 – Select Ignore info about file presence to try to restore files from a backup selected in
the drop-down menu even if they are marked as absent. This option is effective with
backup projects created in older versions of EaseUS Todo Backup. This option is
available only for archived backups.
6 – The Restore Selected button restores only files selected in the list.
7 – The Restore All button restores all files.

Restoring Files Manually
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To restore from a non-archived backup, just copy files and folders from it. This page is
aimed to explain how to restore from archived backups.

EaseUS Todo Backup uses standard file formats: TAR for creating archives and GZIP for
compression. These formats are natively supported on OS X and other operating systems.
This makes it possible to extract files from the archive without using the EaseUS Todo
Backup application. In OS X the Archive Utility.app is the default application for extracting
files from archives.

Double-click on the backup archive file (*.tar or *.tgz) in Finder to extract. The archive
content will appear in the folder where the archive is located. Then copy the files to the
original location on the disk.

To convert a partitioned or encrypted archive to *.tar or *.tgz format, you have to use
command line applications. Then double-click on the archive in Finder. Examples of
command lines can be found below. If you are not familiar with shell applications, prefer
using EaseUS Todo Backup.

Full Archive

You may have multiple archives created at different times (we call them versions). Choose
one of them (the latest if you want to restore the most recent copies of your documents)
and extract it. Older versions of EaseUS Todo Backup also supported Versioned Archive
type which can be treated in the same way as Full Archives.

Incremental Archive

You may have a series of incremental archives containing only those files that were
modified after the previous archive had been created. To restore all the files in the most
recent versions, you should extract all the archives to separate folders. The first (oldest)
archive must contain all the files included in the backup project. Use the files and folders
extracted from this archive as the basis. Move or copy the newest versions of files there
preserving the structure of included files and folders.

Examples of Command Lines

The openssl application is used for decryption. The cat application is used to concatenate
parts of the archive. The tar application is used for decompression. To enter command
lines and run the applications above, use the Terminal.app application located in the
Applications/Utilities folder.

Remember that the elements of the command line should be separated with the "space"
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symbol. If a space symbol is present in the file or folder name, or in the password, replace
it with "\ " (slash and space) in the command line. For example, use "document\ 1.txt"
instead of "document 1.txt".

In command line examples below, parts you should change are underlined. Don't modify
the rest.

To use a command:
1. Copy the command to a text editor (for instance, TextEdit.app).
2. Replace the sample path(s) to the actual file path(s). Replace the password if you have
an encrypted backup. Retain the spaces that separate the parts of the command line.
If a "space" symbol is present in the file or folder name, or in the password, replace it

with "\ " (slash and space) in the command line.
For example, write "document\ 1.txt" instead of "document 1.txt".

3. Select the command line and copy it (Cmd-C).
4. Open the Terminal.app application located in the Applications/Utilities folder.
5. Paste the command (Cmd-V) and press the Return key to run.

If you need to stop the process in Terminal.app urgently, press Ctrl-C.

Concatenate Parts

cat ~/path/vers20090701135457n.tar.aaa ~/path/vers20090701135457n.tar.aab >
~/path/backup.tar

Here:
~/path/vers20090701135457n.tar.aaa – the first part;
~/path/vers20090701135457n.tar.aab – the second part (if you have more parts, put the
path to each separating them with the space symbol);
~/path/backup.tar – the output file path.

The input files (parts) must be present in the command line in the correct order: *.aaa then
*.aab then *.aac and so on.

Decrypt a Blowfish Archive

openssl enc -in ~/path/vers20090701143400n.tar.bfe -bf -d -k password >
~/path/backup.tar

Here:
~/path/vers20090701143400n.tar.bfe – an archive encrypted using the Blowfish algorithm
(see the file extension).
password – the password used to encrypt the archive.
~/path/backup.tar – the output file path.
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Decrypt a Triple DES Archive

openssl enc -in ~/path/vers20090701151110n.tar.3des -des3 -d -k password >
~/path/backup.tar

Here:
~/path/vers20090701151110n.tar.3des – an archive encrypted using the Triple DES
algorithm (see the file extension).
password – the password used to encrypt the archive.
~/path/backup.tar – the output file path.

Decrypt a AES-128 Archive

openssl enc -in ~/path/vers20090701151110n.tar.aes128 -aes-128-cbc -d -k password >
~/path/backup.tar

Here:
~/path/vers20090701151110n.tar.aes128 – an archive encrypted using the AES-128
algorithm (see the file extension).
password – the password used to encrypt the archive.
~/path/backup.tar – the output file path.

Decrypt a AES-256 Archive

openssl enc -in ~/path/vers20090701151110n.tar.aes256 -aes-256-cbc -d -k password >
~/path/backup.tar

Here:
~/path/vers20090701151110n.tar.aes256 – an archive encrypted using the AES-256
algorithm (see the file extension).
password – the password used to encrypt the archive.
~/path/backup.tar – the output file path.

Decrypt a AES-256 Archive and Extract Files

openssl enc -in ~/path/vers20090701153031n.tgz.aes256 -aes-256-cbc -d -k password |
tar -zxv -C ~/Desktop/backup/

Here:
~/path/vers20090701153031n.tgz.aes256 – a compressed archive encrypted using the
AES-256 algorithm (see the file extension).
password – the password used to encrypt the archive.
~/Desktop/backup/ – the path to an existing folder where the extracted files will be written.
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Cloning Disks

Introduction to Disk Cloning

Disk cloning is one of many possible measures you can take to prevent data loss. A disk
clone is an exact duplicate of the entire volume (or entire disk if there is only one partition).
If the original disk is bootable, its clone is also bootable. This means that you can backup
not only your documents but also the operating system. The duplicate of your disk can be
used to boot your computer.

External drives such as HDD or USB flash drives are the best media for a bootable disk
clone.

The process of disk cloning takes quite a lot of time. Usually it isn't convenient to clone
your disk frequently. Subsequent runs of the disk cloning take less time because the
program updates only the modified or removed files. Planning your backup strategy, think
about a combination of disk cloning with regular backups (e.g. incremental or full) that
include only user files. In such case, backing up can be more frequent (for example, daily),
and disk cloning less frequent (weekly or monthly).

If you plan to use your disk duplicate as an emergency working system, the disk for a
clone should be of sufficient capacity. It should be about 10% larger than all of your files
take on the original disk.

It is recommended that you run the Disk Utility application to fix possible file system
problems. The tools that allow you verify your disk are located in the First Aid tab. This
application is in the Applications/Utilities folder.

The disk cloning tool erases everything on the destination disk. Make sure that there are
no critical files on it.

This documentation supposes that you create a system backup to be able to boot from it
on the same computer.

It is recommended that you boot from your emergency disk to make sure that a copy of
your operating system works well.

To specify from what disk to boot your Mac, press and hold the Option (Alt) key before
turning power on.

Before starting cloning, EaseUS Todo Backup turns off the Spotlight indexing for the
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destination drive. If you need to turn it on, use the Privacy settings in the Spotlight section
of the System Preferences.

Requirements for the Destination Disk

Disk cloning requires the OS X Extended (HFS+) file system. This file system has several
subversions such as Journaled or Case-sensitive. It is recommended that the destination
disk has the same format as the source disk. Most drives and USB flash drives have been
formatted as FAT32. You can copy files on these disks but cannot use as a start up disk
until it is properly formatted.

The partition scheme should be GUID Partition Table (GPT).

The destination disk should be writable. If it has any write protection, deactivate it.

The Partitioning and Formatting your Disk section gives you an idea of how to prepare a
disk for creation a bootable copy of OS X.

Partitioning and Formatting your Disk

 Finding out the current partition map scheme
 Finding out the current disk format
 Partitioning your disk
 Formatting your disk

For all tasks described here, use the Disk Utility application located in the
Applications/Utilities folder.

Finding out the current partition map scheme

Select your disk (not a volume) in Disk Utility. The partition map scheme is indicated in the
table.
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Finding out the current disk format

In Disk Utility, select a volume. Its format will be indicated in the middle of the main
window at the top. Also, you can click on the Info button in the toolbar to get more details.

Partitioning your disk

Partitioning can erase all data on your disk.
When you erase your disk, you can choose the partition map scheme. GUID Partition
Table is needed to make the disk bootable.
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To partition your disk, click the Partition button. Then select how many partitions you
need, and specify the name, formatting and size for each of them.

Formatting your disk

Formatting erases all data on your disk.
To format your disk, click the Erase button and specify the disk name and formatting. OS
X Extended formatting is recommended.

The Disk Clone Workspace

To open the disk cloning tools, click the third button in the main window or press Cmd-3.
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1 – Select the destination disk where a copy of the source disk will be saved.
2 – Select the source disk that will be duplicated.
3 – The list of projects.
4 – The content of the source disk. To preview the content of a folder, click on the triangle
next to its name.
5 – Add or delete a projects.
6 – The disk cloning project properties.
7 – An option to exclude items from the cloning process without deleting them from the
backup project. If you exclude a folder, all its content will be excluded too.

Cloning a Disk

The disk cloning tool will delete all files on the destination drive if you clone to this disk for
the first time. Deleting files can take some time. To save your time, you can erase the
destination volume using the Disk Utility application beforehand. There is no need to
erase the destination disk when you clone to it the same source disk again because most
of files can be reused.

1. Select a volume you want to duplicate in the From drop-down list.
The volume must be formatted as OS X Extended (HFS+) and contain OS X installed if

you want your clone drive to be bootable.
2. Select a volume where the duplicate will be saved in the To drop-down list.
Make sure that there is enough space. Note that the existing content of the destination
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volume will be erased. If the formatting of the destination is other than Mac OS Extended,
you have to change its formatting or choose another disk.
3. Set up the disk cloning properties.
4. Exclude files or folders if necessary. To do this, deselect check boxes next to the file or
folder names. It is not recommended to exclude anything outside your Home folder.
5. Click the Start button.

It is recommended that you quit all programs before cloning your drive.

The Disk Cloning Settings

The disk cloning tool lets you change the project name and color. Also, you can activate
scheduled cloning and set up its frequency.

Using the When destination is mounted option, you can allow the program to start clone
automatically when the destination disk is connected to the computer.

Explanations of Disk Cloner Messages

Messages in the disk cloning window instruct you or indicate the current state of the
program. Below are given explanations of them.

Select source and destination
– Suggests you select the source and destination disks.

Clone will not be bootable (Source is not bootable)
– The disk clone will not be bootable because the original disk was not bootable.

Clone will not be bootable (Destination is not bootable)
– The disk clone will not be bootable because the file system or partitioning of the
destination disk does not comply with the requirements.
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Clone may be bootable
– More likely the disk clone will be bootable.

Destination has insufficient space
– The volume of the destination disk must be equal to or greater than the volume of the
source disk.

Source and destination must differ
– The same disk cannot be selected as the source and destination at the same time.
Choose another disk for either the source or destination.

Destination is read only
– The selected destination disk has hardware or software write protection. Deactivate the
protection or select other disk.

Source or destination is not accessible
– The program cannot access a previously selected disk. If you use an external or network
disk, make sure that it is connected. To verify that a disk is accessible, try to preview its
contents in Finder.

OS X Extended (HFS+) required for source and destination
– The file system of the source or destination disk does not comply with the requirements.

Mac OS Extended (Case-sensitive, Journaled) recommended for destination
– Since the source disk has case-sensitive format, it is recommended that you format the
destination disk with the "case-sensitive" option.

File Synchronization

Introduction to File Synchronization

File synchronization is aimed to make copies of files in two folders identical.

File synchronization can be one-way or two-way. When you mirror files from one location
in another, it is called one-way synchronization. This happens when you copy new
versions of files to a backup archive. Your working folder is the source and the backup
folder is the destination.

We talk about two-way synchronization, when one folder contains the newest version of
one file and a second folder contains the last version of another file. Both folders are the
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source and destination. You should take into account that two-way synchronization in
EaseUS Todo Backup is two one-way synchronizations preformed one after another.
Since that, if it makes difference for you which of the folders will be the source first, run
one-way synchronization in one direction and then in the opposite one.

In the Synchronization Settings, you can allow to delete files and folders in the destination
by deactivating the Never delete anything option. Nevertheless, files that have the
Locked property activated, cannot be removed or replaced. To verify this property,
right-click on a file in Finder and choose Get Info.

The synchronization tool also has an option to consider the file modification date.

The Synchronization Workspace

To open the synchronization tools, click the fourth button in the main window or press
Cmd-4.

1 – Add or delete projects.
2 – Project properties.
3 – List of synchronization projects. Along with the project name, there is the date and
time indicating when you synchronized data the last time.
4 – An option to exclude items from the synchronization process. If you exclude a folder,
all its content will be excluded too. An excluded file or folder is treated as it doesn't exist in
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the source.
5 and 7 – Lists of files and folders in the selected folders.
6 – The Analyze button compares the two selected folders. See The Meaning of Colored
Signs and File Names.
8 and 9 – Choose the folders you wish to compare and synchronize.
10 – The direction of the synchronization.
Left to right updates only the content of the right column. The left column is the source.
Right to left updates only the content of the left column. The right column is the source.
Bidirectional updates the content of both columns.

The Meaning of Colored Signs and File Names

The Analyze button compares the two selected folders and shows what the program will
do if you run synchronization. Icons in the middle of the list will indicate what kind of action
will be taken. If a file is not present in the source of destination, its name in the
corresponding list is gray.

Gray circle means that no action will be taken.

Green arrow indicates that the respective file will be copied from the source to the
destination.

Red cross indicates that the respective file will be removed from the destination because it
is not present in the source. This is possible only if you deselect the Never delete
anything check box in the project properties.

Red cross next to the excluded file indicates that the respective file will be removed from
the destination because it was excluded. This is possible only if you deselect the Never
delete anything check box in the project properties.

Contour blue arrow indicates that the destination folder's properties (such as modification
date or colored label) will be updated. The content of the destination folder will remain
unchanged.

Blue triangle indicates that the content or properties of the destination folder will be
updated. Some files or folders of the destination can be updated or deleted.
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Gray file name indicates that a file or folder is not present in one of the lists (source or
destination) while it is present in another.

Synchronizing Files

1. Select two folders to be synchronized. To do this, click on a path box above the left and
right columns.
2. Set up the synchronization direction by clicking on the arrow at the top. The arrow
should point from the source to the destination. By choosing the bidirectional arrow, you
allow updating files in both selected folders.
3. Click the Properties button and check the settings.
4. To find out what the synchronization tool is about to do, click the Analyze button. Icons
in the file list will display if there are different or missing files in the two locations, and how
the program will deal with this.
5. Click the Start button.

The Synchronization Settings

1 – The color of the tag in the project list. This can help you highlight projects by
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importance or by other principle.
2 – The project name. It is displayed in the main window. Note that projects with identical
names are not allowed.
3 – This option prevents the deletion of files in the destination folder if they are not found
in the source folder. Be careful, with this option!
4 – The Consider modification date option is needed for the situation when the
destination folder contains a newer version of a file than the source folder. Select this
check box if you don't want to overwrite the newer version.
5 – Exclude files. While comparing and synchronizing the content of two folders, the
program can disregard files of the specified type. You can also create a custom pattern to
exclude files.
6 – An option to mount network drives automatically. This option can be disabled if the
remote or external drive is (or can be) physically disconnected (e.g. a USB drive). To
check the ability to mount the network drive, unmount it in the Finder and click the Mount
button here.
7 – Automate automatic synchronization when the destination disk is mounted.
8 – Automate file synchronization according to the time schedule.

Exclude Files by Pattern

A folder added to your project may contain some files which you don't want to back up.
The Exclude tool can help you automatically exclude such files.

You can choose a predefined file type or create your own pattern. To do this, activate the
By pattern option and select a file you want to exclude. For example, if you select a
report.txt file and choose the "the same extension" option, all .txt files will be excluded.

A pattern can contain a file name or extension, or both. Several patterns can be combined
to create a complex rule.

To add a pattern:
1. Click the Select button.
2. Select one of radio buttons:
• the same extension to exclude all files of the same type as the sample file has (the part
of the full file name after the most right period.
• the same name to exclude all files with the same name as the sample file has (the part
of the full file name before the most right period).
• the same name and extension to exclude all files with the same name and extension
as the sample file.
3. Choose a sample file to use its name or extension as a pattern.
4. To join the current pattern with the existing one, select the Combine with previous
pattern check box. This way you can exclude several file types from the archive. If you
deselect the check box, a new pattern will replace the existing one.
5. Click Capture.
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Starting Tasks Automatically

Starting a Task by a Schedule

The program can start a backup, cloning or synchronization process automatically with a
certain period of time. You can set up each project's schedule individually in the
project Properties dialog.

In order to scheduled tasks be performed automatically, you should activate the schedule
agent in the Preferences dialog. As soon as you activate the schedule of any project, the
program will remind you to activate the schedule agent. When the time to start a
scheduled project comes, the agent opens the program.

If neither schedule agent nor program were running at a scheduled time, the
corresponding task will be performed later as soon as you open the program.

When you are setting up the schedule, take into account that it is better to choose time
when you computer is less loaded by the user or other autonomously running software.

Starting a Task When a Disk is Mounted

The destination disk of any of your projects can be an external disk such as an USB drive.
You can tell the program to start a corresponding task automatically when its destination
disk is mounted. In other words, when you connect a USB stick, which is set as the
destination, your files will be automatically copied to it. You can activate this feature in the
project Properties dialog by selecting the When destination is mounted check box.

Note that mounting other types of disks like local or network ones cannot start automatic
tasks.

In order to have your task be performed automatically when the program is not open, you
should activate the schedule agent in the Preferences dialog. As soon as you turn on the
auto start of any project, the program will remind you to activate the schedule agent.

It is possible that you activate the When destination is mounted check box together with
the schedule in the same project. In this case, starting a task by the schedule will be
primary. As long as the task is performed by the schedule successfully, plugging in the
destination disk between the scheduled times will not run the task. Only if a task was
finished unsuccessfully at the last time, the program will run it again when you connect the
destination disk.
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Suspending Scheduled Tasks

You can suspend starting scheduled tasks when the regular time is not appropriate for
some reason. For example, you can be in the process of editing some document, and
want to get the document backed up when it is finished.

Suspending tasks for a specified period of time guarantees that the scheduler will be
activated automatically. If you deactivate the scheduler manually, you risk forgetting to
activate it again.

The Suspend Scheduler button in the bottom right corner of the main window indicates
the scheduler mode. Normally, its icon shows a clock.

In the suspended mode, the icon shows an exclamation mark. The same applies to the
menu bar icon.

To suspend all scheduled tasks, click the Suspend Scheduler button. Then select how
long the scheduler should stay deactivated.

Alternatively, you can click on the menu bar icon of EaseUS Todo Backup, choose
Suspend Scheduler… and specify for how long this state should last.

The program resumes the scheduler automatically unless you have selected the
"unlimited time" option. In this case, you should stop the suspended mode manually.
To exit the suspended mode, click the Suspend Scheduler button.
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